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Introduction  
So, you’ve finished your circuit prototype and you’re ready to make it permanent? Tired of those 

messy wires and loose components, and ready for something that looks professional? All you 

need is a good PCB program and you’re ready to go! This tutorial will guide you through the 

process of turning a circuit into a printed circuit board file that you can then send away to the 

fabrication house. Wait a few days and, like magic, you will have a shiny circuit board onto 

which you can solder your components.  

   

Creating a new project  
Begin by launching the CadSoft EAGLE software. This will open the control panel window, 

where you can navigate to libraries, projects, and other relevant files. Choose File → New → 

Project to begin a new PCB project. This will create a subdirectory where the files associated 

with your PCB will be kept. Name the project something like “led_ex”, since we will be making 

a simple LED circuit in this tutorial.  

  
   

There are a number of versions of EAGLE out there.  In CAEN and in our lab, we have the full-

featured, licensed version.  You can also download a freeware version of EAGLE that is very 

limited in comparison to the non-profit and commercial versions of the program. Most 

importantly, the freeware version is limited to one schematic sheet and two layers of routing 

(wires) on the boards. More advanced boards may require multiple schematic sheets and up to 

seven wire layers. So if you try to do your designs at home you may find those limits cause you 

problems.  This tutorial should work just fine on the freeware version however. 

   

Schematic vs. Board  
The first thing to note about a project is that you will have two separate files that will be very 

closely linked. The first is the schematic, in which you define the parts and connections you wish 

to exist on your design. You will then use your schematic to create the physical board layout by 

moving the pieces into their desired location. The final task will be to route the signals 



(remember, with two layers) between components. This task can be done using an autorouter 

function, which is generally good at getting at least very close to what you need. We will discuss 

this function later.  

   

The Schematic  
Start your project by creating a new schematic file with File→New→Schematic. Save it into 

your project directory. For now, ignore the board file altogether, as it will be unnecessary until 

we want to start laying parts out. In fact, if you create the corresponding board file, you will 

always have to have it open while working on your schematic in order to keep them consistent. If 

you do not, you will have to add parts and connections to the board file when it is reopened in 

order to regain consistency. You can also delete the board file and remake it, but you will not 

keep any of your components in the positions that you previously placed them.  

   

To navigate the schematic, you can scroll the mouse wheel to zoom in and out, and click-and-

drag with the mouse wheel to position the screen. On the left, you will see a toolbar and a 

window to choose between schematics. Since we will only have one schematic file, you can 

close the latter. The toolbar has everything you will need to design your circuit.  

   

Adding components  

Start by adding an LED by clicking the “Add” tool, which will bring up your full library of 

components. Scroll down and expand the “led” section, which is the LED library. Scroll down 

again and find the “LED” section, and click LED5MM. On the right side of the interface 

window, the schematic and board icons for a 5mm LED will appear, with a description below. 

This is often useful when you are looking for a specific component as you will be able to see 

things like the number of pins, the shape, and whether it is a surface-mounted or through-hole 

component.  

   

Add the LED to your schematic and hit escape a couple times so as to not add the component 

multiple times. Now, suppose you want another LED. Click the “Copy” tool  and left-click 

on the component, which will allow you to place a second LED. Now suppose you wanted to 

copy both LEDs so that you had four. This is not as intuitive a process. Start by clicking the 

Copy button, then clicking the Group button  immediately after. Drag a box or click and draw 

a perimeter (terminated by a right-click) and then right click a component inside the group. One 

of the options will be to perform a copy of the group, which will then work just as with copying 

one component. Use this same process for other actions such as Move or Delete. Once you are 

comfortable with this, delete all but one LED.  

   

Now we want to add a couple more components. Let’s add a resistor (resistor→R-US→R-

US_0309/10) to keep the current flow in check, potentiometer (pot→TRIM_US→TRIM_US-

RJ9W) to be able to vary the brightness of the LED, an on/off switch (switch→TL32WO), and a 

DC jack (con-jack→DCJ0202) for power input.  



  
(Note: while you are moving your devices around with the Move tool, you can rotate them by 

right-clicking.)  

   

Wiring and naming  
Now we need to connect our components so they do something useful. It looks like you’d want 

to use the Line tool , but in general you really want to do your wiring with the Net tool  as 

the wire tool is generally regarded as less useful for reasons historical and current.
1
 

   

For the purpose of this exercise, let’s assume the DC jack is connected to a 5V source (this way 

we don’t have to worry about a voltage regulator). Then, we can define 5V within our circuit by 

adding a 5V connector (supply1→+5V). You can connect this by placing the end next to pin 3, 

or by placing it elsewhere and adding a net. After you have done this, any other +5V pins that 

you add to the circuit will connect to the DC jack! Do the same for ground, found in the same 

library. Then, add nets until your circuit looks similar to this:  

   

  

                                                 
1
 The Net tool and Wire tool distinction is a bit odd.  Apparently the original purpose of the “wire” tool was just to 

draw lines on the schematic for documentation purposes.  That (obviously) confused a lot of people and so it now 

can be used to draw pretty pictures and connect things (see a discussion here for example)  

http://arduino.cc/forum/index.php?topic=61887.0


You may end up having nets crossing for the DC jack or elsewhere. This is okay, as long as you 

did not inadvertently connect the nets. You can easily check this by using the Show tool , 

which will bring up the net’s attributes in the bottom information bar.  

   

One last thing we need to do is to set the value of the resistor that we want to use. Obviously, this 

will not affect your circuit directly since you will solder on whatever resistor you wish, but it is 

good practice to give your devices a value. Use the Value tool on the resistor and set it to 

1KOhm 

   

Just as the ground and +5V components are innately connected, so too are nets with the same 

name. In this way, you can connect nets on opposite sides of your schematic without a wire 

cluttering your screen. This is not very useful for a simple circuit, but when you add enough nets 

to start seeing a spaghetti effect, you will want to take advantage of this. Let’s try it by separating 

the LED from the resistor and ground. Use the Delete tool  to remove the physical wire, and 

then move the resistor and ground elsewhere in the design. Now add a hanging net off the LED 

and the resistor. Use the Name tool  to name each wire to something like LR. When you 

name the second wire, you should be prompted to make a connection, since another wire already 

has this name – this is a good indicator that there actually is a connection there. In addition, you 

probably want to have the name show up on the wire – to do this, use the Label tool and click on 

each wire, and place the name next to it.  

  
   

Adding libraries  
There are many parts that you may wish to add that aren’t in EAGLE’s (extensive) set of 

libraries. If this is the case, you can find a footprint for the part online if someone has created and 

distributed it, or you may create a new component to match your exact needs.  

   

SparkFun has created a large library containing many of their components. If you were interested 

in using a component from their library, you could add the SparkFun library to your collection. 

You can find it at http://www.sparkfun.com/tutorial/SparkFunEagle-03-01-10.zip. Extract the 

files to the EAGLE-5.9.0/lbr directory and you will have access to the components when you 

restart EAGLE.  

  
   

http://www.sparkfun.com/tutorial/SparkFunEagle-03-01-10.zip


Creating a new component or library  
What if you couldn’t find your part online, or you simply wanted to make your own so that you 

could be sure that it is exactly what you want? EAGLE allows you to create a footprint to match 

your exact specifications and save it in your own custom library. For the purpose of this tutorial, 

we will not go into greater detail on this, but there is an accompanying document covering the 

creation of a new component library for EAGLE.  

   

The Board  
Now that you have your circuit connections made, you need to design the physical board! From 

your schematic window, click the Board icon to create a board file that will correspond to your 

schematic. Click yes when you are prompted to associate the files.  

  
You should now see a window with a few parts scattered outside a box like so:  

  
   

   

Device placement  
The first thing we need to do is choose a size for our board. Obviously the default is much larger 

than what we need. Use your move tool on the corners to resize the box to about 1.5”x1”. Now, 

we simply need to place the components where we want them. An obvious choice for the DC 

jack and the switch is to face outwards along an edge. Other than that, the positioning for this 

circuit is rather arbitrary, but it is better to place connected components near each other if 

possible. There is an exception, however, when you have a net connected to many components 

(such as power and ground). The connections between these components can be changed as you 

are moving the parts. Simply click the Ratsnest tool , and EAGLE will re-route your 

connections to optimize length, if possible. When designing larger circuits, you should click this 

tool every-so-often to continuously optimize your connections.  



   

Once you have your components laid out, you should have something that looks like this:  

  
   

As you can see, the footprints for the DC jack and switch are outside the boundaries. This is fine, 

as they are only there to show us the outline of the component. What generallymatters is that the 

green layers (which are the physical connections to the board) are within the boundaries. Of 

course, we also do not want our components overlapping, either, which the footprints help us to 

avoid.  

   

Layers  
As mentioned before, our board contains two layers where wires can be placed. However, there 

are a few more layers associated with our design. One of these is the silkscreen layer. This is a 

non-conductive layer on the very top of our physical board where we can print important or 

helpful information – things like types, names, and values of components, or a date and revision 

number of our design. It is also where you want to print the outlines of your components to make 

population of the board easier when you finally solder the pieces.  

   

Other layers associated with a 2-layer board are the top and bottom solder resist layers, which 

consist of a material that helps to keep solder on the solder pads so that it does not leak into other 

areas and create unwanted connections.  

   

Note that the layers described above are those that are a part of the physical board, and they are 

not the same as the layers in your schematic and board files – though they are closely related. 

Here is a brief description of the layers in EAGLE that we should know about:  

   

       Top – The top signal routing layer.  

       Bottom – The bottom signal routing layer.  

       Pads – Connections to components. These go through all physical layers.  



       Vias – Holes to connect different layers. Discussed later.  

       Unrouted – Shows the wires that have not been set to the top and bottom layers yet.  

       Dimension – The board outline.  

       tPlace/bPlace – Top and bottom layers for silkscreen information.  

       tOrigins/bOrigins – Crosshairs allowing interaction with components.  

       tNames/bNames – Shows names corresponding to components.  

       tValues/bValues – Shows values corresponding to components.  

       tStop/bStop – Solder resist layers.  

   

When you create your final design files (gerbers), you will decide which board file layers to 

associate with each physical layer. This will be discussed later.  

   

Play around with the layer filter (Display tool ) to show/hide different layers of your design. 

This will help you to see which aspects of the design are associated with each layer.  

  
   

Mounting  
You will find that PCBs almost always have through-holes in them to allow for mounting if the 

user chooses. This would be a good time to add a few to our board. Although you would be able 

to add these directly to the board file, you should always add new components to the schematic 

to keep consistency (remember, always have the schematic and board files open concurrently 

after your board file is created). Add four SparkFun components called “stand-offs” to the 

schematic. They will simultaneously be added to your board file, where you can move them to 

the four corners of the board. Move components if necessary to make room for the hole and a 

moderate-sized screw that would be used with it (the red outline shows the dimensions of the 

screw).  

   

Routing and autorouting  
The final step is to convert those ugly floating wires into routed, physical ones. It would be 

rather simple to do this by hand with a small circuit like this, but a daunting task with much 

larger designs. Let’s use the auto-router to take care of laying out the nets for us. Hit the Auto 

button, choose 8 mil for the routing grid option (for tighter wire spacing), and ignore the other 

options for now. Voila! Your circuit should look like this:  



  
(Notice that the blue and red wires cross, while similar colors never do)  

   

Vias  
An important concept in PCB creation is the via. These are small, circular, conductive holes that 

allow signals in different layers to connect to each other, and are shown in EAGLE as green 

circles like the ones in the middle of the switch footprint. You can see them in circuit boards as 

small holes that puncture through the board and are often lined by a metal. Why are they useful? 

Well, if you have taken a course on graph algorithms, you know that having only a 2-

dimensional surface to make all of your connections is extremely limited. Adding through holes 

essentially adds a third dimension, giving many more routing possibilities. Our simple circuit 

above did not require the use of any vias because two layers of wires was enough to not have 

anything cross, but for larger circuits, vias are essential.  

   

Labeling  
One final, important step in our PCB design is some labeling. This is one thing you can add to 

your board file while ignoring the schematic. First, we need to make sure we are using vector 

fonts. Go to Options→User interface and make sure the option is set. This will ensure that 

whatever we place on the board is exactly the same as what is printed at the fabrication house.  



  
   

Let’s start by deciding which layers we want to show up on our silkscreen. Almost all labeling 

you add should be put on the tPlace layer. This is the layer you will also find the component 

outlines. In addition, you can choose whether you want tNames and tValues included on your 

silkscreen. Change your Display tool filter to show the information you want on your silkscreen, 

along with things like the top layer, dimensions, vias, and pads. This will give you a rough idea 

of how everything on the top will be laid out. Now we can add some labeling. Choose the Text 

tool, enter the text you wish, and make sure it is set to the tPlace layer. Add things like a title and 

version, the designer name, and the date. You might end up with something like this:  

  
   

(Note: Hold Alt while placing a label to get greater resolution on position.)  



Errors and design rule check  
The very last thing we should do, of course, is check our work. EAGLE provides an error 

checking system and a design rule check system. First, check for any errors in your board file. 

You may come up with things like a width error when you have a component too close to 

another or too close to the edge of your board. Fix any errors you run into.  

  
   

Next, we should use the DRC (design rule check) tool to see if our board is in compliance with 

certain design rules. This will come up with a window with tabs representing different 

constraints. The ones relevant to our design are clearance and distance. Run these checks with 

settings based on what your fabrication house requires. For example, many fabrication houses 

require a minimum clearance of 5mil. If nothing happens when the check is run, your design is 

good to go. If you do get an error, in clearance for example, you may have to alter your layout to 

fix it.  

   

CAM processing and gerber files  
Our board design is finally complete and we are ready to create the files that will get sent to the 

fabrication house. To do this, we use the CAM tool:  

  
   

The CAM tool allows us to run processes on our board file to create the files that the fabrication 

house will directly use to create our board. These are called gerber files. For a 2-layer board, we 

will need 7 files: top, bottom, silkscreen, top solder, bottom solder, and two drill files. Let’s start 

by making the drill files. Go to File→Open→Job and choose excellon.cam. On the right side of 

the window, you should scroll down and see the Drills and Holes layers selected, which means 

these two layers are used to produce the gerber files. Process the job and .drd and .dri files 

should appear in your project directory.  

   

Next, we will create the other five files. The types of files you want to create will depend on 

which fabrication house you choose. PCBFabExpress, for example, wants gerber274x gerber 

files for a 2-layer board with solder stops and a silkscreen. So, we select the gerber274x.cam job. 

This brings up 5 tabs across the top, each representing a different gerber file:  

  
   

The only thing you really need to consider for each tab is which layers to associate with each 

layer. It’s probably best not to touch any of them except the silkscreen. As talked about earlier, 



you should choose what information you wish to be printed here. Most likely this means tPlace 

along with tNames and tValues if you choose.  

   

Hit the process button and the other five gerber files will show up in your directory! Take these 7 

files, place them in a new directory, and zip them up. You are now ready to order a PCB from 

your desired fabrication house. Congratulations!  

 



Other Useful Information 
This document is by no means all you’ll need.  In fact, it’s barely a start.  This section has a few 

useful references 

 

Further reading 
The above tutorial is fairly basic and EAGLE is fairly complex.  There are lots of other resources 

out there.  The best that supplement this document (in our opinion) are: 

 The official EAGLE tutorial.  Fairly complete, if a bit long (75 pages) and    

 A basic video walkthrough Jason of RPC Electronics hosted on YouTube.  It’s pretty 

good and you get a good sense of how easy it is to use the mouse to navigate around once 

you know what you are doing. 

 Watch  Limor “Ladyada” Fried route a rather large board.  Again, it’s helpful to see 

someone who knows what they are doing using the tools.  It should be noted she (like 

many others) doesn’t trust the autorouter. 

 http://www.sparkfun.com/tutorials/115 is a pretty nice high-level tutorial/hints section. 

 

Other reference stuff: 
Handy tool list (taken from the official EAGLE tutorial).  

 

http://www.cadsoft.de/wp-content/uploads/2011/05/tutorial_en.pdf
http://www.youtube.com/watch?v=qG0O9LKH-_E
http://www.adafruit.com/blog/about/
http://www.adafruit.com/blog/2009/11/19/pcb-routing-with-eagle-video/
http://www.sparkfun.com/tutorials/115

